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Warranty
The serial hardware is warranted against defects in materials and workmanship for a period of one year from the
shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or repl
equipment that proves to be defective during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evid
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that 
execute programming instructions if National Instruments receives notice of such defects during the warranty pe
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outs
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully re
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader 
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any dam
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL  INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS 
ANY WARRANTY OF MERCHANTABILITY  OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’ S RIGHT TO RECOVER DAMAGES CAUSED 
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL  INSTRUMENTS SHALL BE LIMITED  TO THE AMOUNT THERETOFORE PAID BY THE 
CUSTOMER. NATIONAL  INSTRUMENTS WILL  NOT BE LIABLE  FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of 
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence.
Any action against National Instruments must be brought within one year after the cause of action accrues. Natio
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The wa
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to 
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product;
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third partie
or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mecha
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, wit
the prior written consent of National Instruments Corporation.

Trademarks
CVI™, LabVIEW™, and natinst.com™ are trademarks of National Instruments Corporation.

Product and company names referred to in this manual are trademarks or trade names of their respective compa

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliab
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving m
or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part
user or application designer. Any use or application of National Instruments products for or involving medical or cl
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeg
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should
continue to be used when National Instruments products are being used. National Instruments products are NOT i
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard huma
and safety in medical or clinical treatment.
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FCC/DOC Radio Frequency Interference Compliance

This equipment generates and uses radio frequency energy and, if not installed and used in strict acc
with the instructions in this manual, may cause interference to radio and television reception. Classifi
requirements are the same for the Federal Communications Commission (FCC) and the Canadian 
Department of Communications (DOC). The FCC/DOC classification is indicated on a label on the de
If an FCC ID is present, the equipment is Class B; otherwise, it is Class A. Look at the product to dete
the classification, then read the appropriate information below regarding the compliance of your prod

Class A

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, purs
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harm
interference when the equipment is operated in a commercial environment. This equipment generate
and can radiate radio frequency energy and, if not installed and used in accordance with the instruct
manual, may cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be required to corre
the interference at his own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipm
Regulations.
Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel b
du Canada.

Class B

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class B digital device, purs
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harm
interference in a residential installation. This equipment generates, uses and can radiate radio freque
energy and, if not installed and used in accordance with the instructions, may cause harmful interfere
to radio communications. However, there is no guarantee that interference will not occur in a particul
installation. If this equipment does cause harmful interference to radio or television reception, which 
be determined by turning the equipment off and on, the user is encouraged to try to correct the interf
by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is conne

• Consult the dealer or an experienced radio/TV technician for help.

Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipm
Regulations.
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel b
du Canada.
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FCC Notices to User
Changes or modifications not expressly approved by National Instruments could void the user’s autho
to operate the equipment under the FCC Rules.
This device complies with the FCC rules only if used with shielded interface cables of suitable qualit
and construction. National Instruments used such cables to test this device and provides them for s
to the user. The use of inferior or nonshielded interface cables could void the user's authority to oper
the equipment under the FCC rules.
If necessary, consult National Instruments or an experienced radio/television technician for addition
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home
Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Government
Printing Office, Washington, DC 20402.
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This manual contains instructions to help you install and configure the
National Instruments serial hardware and the NI Serial software for 
Windows NT. The serial hardware covered by this manual includes the
AT-232/2, AT-232/4, AT-485/2, and AT-485/4. This manual assumes th
you are already familiar with Windows NT.

Organization of This Manual
This manual is organized as follows:

• Chapter 1, Introduction, explains how to use this manual, lists what 
you need to get started, provides an overview of the serial hardwa
and the NI Serial software, and describes optional equipment you 
order.

• Chapter 2, Installation and Verification, contains instructions to help 
you install the NI Serial software, serial hardware, and cables, and
verify the installation. 

• Chapter 3, Configuration, contains instructions to help you view or 
change the communication port settings.

• Chapter 4, Using Your Serial Hardware, describes how to set the 
hardware transceiver control mode for your RS-485 interfaces and 
some general programming requirements.

• Appendix A, Specifications, describes the characteristics of the seri
hardware, the NI Serial software, and the recommended operating
conditions.

• Appendix B, Serial Port Information, discusses the RS-232, RS-422
and RS-485 standards and explains some of the issues involved w
these types of serial communication.

• Appendix C, Uninstalling the Serial Hardware and Software, explains 
how to uninstall your serial hardware and NI Serial software.

• Appendix D, Troubleshooting and Common Questions, describes how 
to troubleshoot problems and answers some common questions.

• Appendix E, Customer Communication, contains forms you can use to
request help from National Instruments or to comment on our produ
and manuals.
© National Instruments Corporation xi AT Serial for Windows NT
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• The Glossary contains an alphabetical list and description of terms
used in this manual, including abbreviations, acronyms, metric 
prefixes, mnemonics, and symbols.

Conventions Used in This Manual
This manual uses the following conventions:

» The » symbol leads you through nested menu items and dialog box op
to a final action. The sequence File»Page Setup»Options»Substitute 
Fonts directs you to open the File menu, select the Page Setup item, select 
Options, and finally select the Substitute Fonts option from the last 
dialog box.

This icon to the left of bold italicized text denotes a note, which alerts y
to important information.

This icon to the left of bold italicized text denotes a caution, which advi
you of precautions to take to avoid injury, data loss, or a system crash

bold Bold text denotes the names of menus, menu items, dialog boxes, or d
box buttons or options.

bold italic Bold italic text denotes a note or caution.

italic Italic text denotes disk names, emphasis, a cross reference, or an 
introduction to a key concept.

monospace Text in this font denotes text or characters that you should literally ent
from the keyboard, sections of code, programming examples, and syn
examples. This font is also used for the proper names of disk drives, pa
directories, programs, subprograms, subroutines, device names, funct
operations, variables, filenames and extensions, and for statements a
comments taken from programs.

monospace bold Bold text in this font denotes the messages and responses that the com
automatically prints to the screen.

!

AT Serial for Windows NT xii © National Instruments Corporation
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Related Documentation
The following documents contain information that you might find helpf
as you read this manual:

• ANSI/EIA-232-D Standard, Interface Between Data Terminal 
Equipment and Data Circuit-Terminating Equipment Employing 
Serial Binary Data Interchange

• EIA/RS-422-A Standard, Electrical Characteristics of Balanced 
Voltage Digital Interface Circuits

• EIA-485 Standard, Standard for Electrical Characteristics of 
Generators and Receivers for Use in Balanced Digital Multipoint 
Systems

• Microsoft Win32 Software Developer Kit, Online Documentation for 
Win32 Overviews, Win32 Reference, and Microsoft Windows NT 
System Guide, Microsoft Corporation

• NS16550AF Universal Asynchronous Receiver/Transmitter with 
FIFOs, National Semiconductor

Customer Communication
National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with o
products, and we want to help if you have problems with them. To mak
easy for you to contact us, this manual contains comment and configura
forms for you to complete. These forms are in Appendix E, Customer 
Communication, at the end of this manual. 
© National Instruments Corporation xiii AT Serial for Windows NT
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Introduction

This chapter explains how to use this manual, lists what you need to g
started, provides an overview of the serial hardware and the NI Serial 
software, and describes optional equipment you can order.

How to Use This Manual

Yes

No

Chapter 2

Chapter 3

Write Application Program

Passes?

Gather What You Need
to Get StartedChapter 1

Install the NI Serial Software

Learn About Transceiver
Control Modes

Review Programming
Requirements

Install the Serial Hardware

Configure the Serial Port

Verify the Installation

Connect the Cables

Troubleshooting

Chapter 4
l for Windows NT
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What You Need to Get Started
Make sure you have all of the following items before you attempt to ins
the serial hardware and software:

❑ Windows NT version 4.0 or later installed on your computer

❑ One of the following serial boards, which is included in your kit:

AT-232 (two or four port)
AT-485 (two or four port)
AT-232 (two or four port) Isolated
AT-485 (two or four port) Isolated

❑ 3.5 in., high-density disk (1.44 MB), NI Serial Software for 
Windows 95/98 and Windows NT, which is included in your kit

If you have a four-port interface, you also need a 10-position modular j
to DB-9 cable.

Optional Equipment
Call National Instruments for more information about the following 
optional equipment:

• DB-9 RS-485 termination connector (AT-485 only)

• 10-position modular jack to DB-9 cable (four-port boards only)

• 10-position modular jack to DB-25 cable (four-port boards only)

• RS-232 9-pin to 9-pin null modem cable

• RS-232 9-pin to 25-pin null modem cable

Serial Hardware Overview
The serial hardware gives you a variety of solutions for serial 
communications. The AT-232 boards work with the RS-232 protocols, a
the AT-485 boards work with the RS-422 and RS-485 protocols. You c
use the AT-232 boards for serial communication up to distances of 50
You can connect the AT-485 boards with up to 31 devices using serial c
lengths up to 4,000 ft. 
AT Serial for Windows NT 1-2 © National Instruments Corporation
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The AT boards are available in three different versions:

• Shared IRQ: All ports on the board share the same IRQ.

• Isolated: All ports on the board are isolated and share the same IR

• Each port requires a separate IRQ (no longer ships with the NI Se
software for Windows 98/95).

Additionally, the AT serial boards are available in a two-port version 
(AT-232/2 and AT-485/2) or a four-port version (AT-232/4 and AT-485/4
The two-port versions use DB-9 connectors. The four-port versions us
10-position modular jacks to provide all four connections on a single b
panel. Optional cable accessories convert the 10-position modular jack
either DB-9 or DB-25 connectors with standard pinouts. Throughout th
manual, references to AT serial boards generally refer to all port versio
of the boards.

The isolated AT-232 and AT-485 boards are designed for applications 
harsh environments. Isolated ports provide reliable communication in 
situations involving ground loops from different ground levels or high 
common mode voltage induced on the lines in noisy environments. Th
non-isolated ports may not provide reliable communication in those 
situations. The isolation between each communication port and the hos
ensures safe operation of the PC and the devices connected to other 
on the same board in case of accidental high voltages on communicat
lines.

The AT-485 boards support four hardware transceiver control modes f
reliable communication with two-wire and four-wire devices. Refer to 
Chapter 4, Using Your Serial Hardware, for more information about 
transceiver control modes.

All of the serial hardware uses standard 16550-compatible UARTs 
(Universal Asynchronous Receiver/Transmitters) for 100 percent 
compatibility with standard PC COM ports. The serial hardware conta
FIFOs (First-In-First-Out buffers) for reduced susceptibility to interrupt
latency and faster transmission rates. Full Plug and Play compatibility g
you the convenience of switchless configuration and installation. Refe
Appendix A, Specifications, for more information about the serial 
hardware specifications and operating conditions.
© National Instruments Corporation 1-3 AT Serial for Windows NT
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NI Serial Software Overview
The NI Serial software for Windows NT includes a native Windows NT
kernel driver that can provide full interrupt-driven, buffered I/O for 
multiple COM ports. Using this driver, you can obtain a maximum bau
rate of 115.2 KBaud. The NI Serial software also provides a configurat
utility, which is integrated with the Windows NT Control Panel. Refer t
Appendix A, Specifications, for more information about software 
specifications and recommended operating conditions.

The NI Serial software includes the following components:

• Device driver

• Diagnostic test

• Configuration utility 

The NI Serial software supports all National Instruments serial hardwa
including all AT, PCI, PXI, CompactPCI, and PCMCIA versions.

Optional Programming Tools
Your kit includes the NI Serial software for Windows 98/95 and 
Windows NT. In addition, you can order the LabWindows/CVI or 
LabVIEW software from National Instruments. LabWindows/CVI and 
LabVIEW include instrument driver libraries that make it easier to 
communicate with your serial instruments.

LabWindows/CVI is an interactive ANSI C development environment f
building test and measurement and instrument control systems. It inclu
interactive code-generation tools and a graphical editor for building 
custom user interfaces. It also includes built-in libraries for IEEE 488.2
VXI, RS-232 control, and plug-in data acquisition. When you order 
LabWindows/CVI, you also get hundreds of complete instrument drive
which are modular, source-code programs that handle the communica
with your instrument so that you do not have to learn the programming
details.

LabVIEW is a complete programming environment that departs from t
sequential nature of traditional programming languages and features a
graphical programming environment. It includes all the tools needed fo
instrument control, data acquisition, analysis, and presentation. LabVI
also includes an extensive instrument driver library.
AT Serial for Windows NT 1-4 © National Instruments Corporation
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For more information about LabWindows/CVI and LabVIEW, contact 
National Instruments.

Using the Serial Hardware with Other National 
Instruments Products

You can use standard serial I/O functions in LabVIEW and 
LabWindows/CVI with any National Instruments serial interface, once 
you have installed the hardware and software. If you already have 
LabVIEW or LabWindows and want to use it with your serial hardware
refer to your LabVIEW or LabWindows documentation for information 
about serial I/O functions.
© National Instruments Corporation 1-5 AT Serial for Windows NT
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Installation and Verification

This chapter contains instructions to help you install the NI Serial softwa
serial hardware, and cables, and to verify the installation.

Installing the Microsoft PnP ISA Enabler Driver
When you install an AT board, you must install the PnP ISA Enabler 
Driver.

The AT serial hardware is Plug and Play. Windows NT 4.0 does not sup
Plug and Play. In order for Windows NT to detect and install the Plug a
Play hardware, you must install the PnP ISA Enabler driver included o
your Windows NT 4.0 CD-ROM. Complete the following steps to insta
the driver:

1. Locate the Pnpisa.inf  file in the Drvlib\Pnpisa\X86  folder on 
the Windows NT 4.0 CD-ROM.

2. Right-click on the Pnpisa.inf  file, then select Install  on the menu 
that appears.

3. Restart the computer.

Install the NI Serial Software
Install the NI Serial software for Windows NT before you install the 
hardware. Make sure that you have already installed the PnP ISA Ena
driver as described in the previous section.

1. Log on as Administrator  or as a user who has Administrator  
privileges.

2. Select Start»Settings»Control Panel.
l for Windows NT
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3. Double-click on the Add/Remove Programs icon in the Control Panel 
to launch the Add/Remove Programs applet. A dialog box similar 
the one in Figure 2-1 appears.

Figure 2-1.  Add/Remove Programs Properties Dialog Box

4. Click on the Install  button.

5. When prompted, insert the NI Serial Software for Windows 95/98 and
Windows NT (Setup Disk), and click on the Next button to proceed. 
The software installation wizard begins with the screen shown in 
Figure 2-2.
AT Serial for Windows NT 2-2 © National Instruments Corporation
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Figure 2-2.  NI Serial Setup Screen

The setup wizard guides you through the necessary steps to insta
NI Serial software. You can go back and change values where 
appropriate by clicking on the Back button. You can exit the setup 
where appropriate by clicking on the Cancel button.

Note This installation backs up the Microsoft Windows NT serial driver serial.sys  
to serial.bak  and then overwrites serial.sys . You can find serial.sys  in 
the Windows NT.....\system32\drivers  directory.

The software installation is complete. Proceed to the next section, Install 
the AT Serial Hardware.

Install the AT Serial Hardware
This section describes how to install your AT serial board.

Note If you are installing an AT-485, you might need to adjust the value of the bias 
resistors, depending on your application. For more information, refer to 
Appendix B, Serial Port Information.

Caution Electrostatic discharge can damage several components on your board. To avoid 
such damage in handling the board, touch the antistatic plastic package to a me
part of your computer chassis before removing the board from the package.

!

© National Instruments Corporation 2-3 AT Serial for Windows NT
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Complete the following steps to install your AT serial board:

1. Turn off your computer. Keep the computer plugged in so that it 
remains grounded while you install the AT serial board.

2. Remove the top or side cover of the computer.

3. Remove the expansion slot cover on the back of the computer.

4. Insert the AT serial board into an unused slot with the serial connec
sticking out of the opening on the back panel. Make sure that you in
the board all the way into the slot. The board may seem to click firm
into place, even though it is only part of the way in. Figure 2-3 sho
the installation of an AT serial board.

Figure 2-3.  AT Serial Board Installation

5. Screw the mounting bracket of the AT serial board to the back pan
rail of the computer.

6. Replace the cover, and turn on your computer.
AT Serial for Windows NT 2-4 © National Instruments Corporation
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7. Windows NT displays one or more New Hardware Found dialog 
boxes, depending on your serial hardware. In each dialog box, make 
sure that Windows Default Driver is selected, and click on OK .

8. The serial configuration software displays a PnP Port Configuration 
dialog box. Select a nonconflicting base I/O address and IRQ sett
for the port/card, and click on OK . For more information on selecting
resources for your post/card, refer to the Resource Settings section of 
Chapter 3, Configuration.

9. After you have selected the resources for all ports, choose to restart
computer when the system prompts you.

The serial hardware installation is now complete.

Verify the Installation

Determine Which Physical Port Is Associated with COMx
Select Start»Settings»Control Panel, and double-click on niports. A list 
showing installed National Instruments ports with their logical COMx 
names appears. If your interface is not on the list, refer to Appendix D, 
Troubleshooting and Common Questions.

Select the COM port you want and click on the Settings button to display 
the General Port Settings dialog box for that port. This dialog box 
displays the serial number of the serial hardware and the physical port 
number starting at 1. On all serial hardware, PORT1 refers to the top port, 
PORT2 refers to the next port down, and so on. 

When you have finished verifying the driver installation and physical port,
proceed to the next section, Run the Diagnostic Test.

Run the Diagnostic Test
To verify and test the installation, run the diagnostic program that cam
with your NI Serial software. The diagnostic program verifies that your
serial driver is installed properly, that the configuration of your hardwa
does not conflict with anything else in your system, and that the serial
driver can communicate with your hardware correctly.

To run the test, select the diagnostics item under Start»Programs» 
National Instruments Serial.
© National Instruments Corporation 2-5 AT Serial for Windows NT
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If the diagnostic test completes with no failures, your serial hardware 
and software are installed properly. If it fails, refer to Appendix D, 
Troubleshooting and Common Questions, for troubleshooting instructions.

Connect the Cables
For the two-port AT serial boards, you can use the standard DB-9 conne
found on most serial cables. To use the DB-9 connector with the four-p
AT serial boards, you need the 10-position modular jack to DB-9 cable
(available from National Instruments). This cable is included with the 
isolated four-port kits. You can also use a DB-25 connector with the 
four-port AT serial boards by ordering the 10-position modular jack to 
DB-25 cable from National Instruments.

Note To achieve the specified isolation voltage for four-port isolated AT boards, use
ONLY the 10-position modular jack to DB-9 cable included in your four-port 
isolated AT serial board kit.

DB-9 Connector
Figure 2-4 and Table 2-1 give the pin locations and descriptions of the
DB-9 connector, which is found on the two-port AT serial board and th
10-position modular jack to DB-9 cable.

Figure 2-4.  DB-9 Connector Pin Locations

Table 2-1.  DB-9 Pin Descriptions

DB-9 Pin 232 Signal 485 Signal

Pin 1 DCD* GND

Pin 2 RXD CTS+ (HSI+)

Pin 3 TXD RTS+ (HSO+)

PIN 1

PIN 9PIN 5

PIN 6
AT Serial for Windows NT 2-6 © National Instruments Corporation
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Modular Jack Connector
Figure 2-5 and Table 2-2 give the pin locations and descriptions of the
10-position modular jack, which is found on the four-port AT serial boa

Figure 2-5.  10-Position Modular Jack Pin Locations

Pin 4 DTR* RXD+

Pin 5 GND RXD–

Pin 6 DSR* CTS- (HSI-)

Pin 7 RTS RTS– (HSO–)

Pin 8 CTS TXD+

Pin 9 RI* TXD–

* These signals are not supported by the isolated 232 ports.

Table 2-2.  10-Position Modular Jack Pin Descriptions

10-Position
Modular Jack AT-232 Signal AT-485 Signal

Pin 10 DCD* GND

Pin 9 RXD CTS+ (HSI+)

Pin 8 TXD RTS+ (HSO+)

Pin 7 DTR* RXD+

Pin 6 GND RXD–

Pin 5 DSR* CTS– (HSI–)

Table 2-1.  DB-9 Pin Descriptions (Continued)

DB-9 Pin 232 Signal 485 Signal

Pin 10Pin 1
© National Instruments Corporation 2-7 AT Serial for Windows NT
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DB-25 Connector
Figure 2-6 and Table 2-3 give the pin locations and descriptions of the
DB-25 connector, which is on the optional 10-position modular jack to
DB-25 cable. 

Figure 2-6.  DB-25 Connector Pin Locations

Pin 4 RTS RTS– (HSO–)

Pin 3 CTS TXD+

Pin 2 RI* TXD–

Pin 1 No Connect No Connect

* These signals are not supported by the isolated 232 ports.

Table 2-3.  DB-25 Pin Descriptions

DB-25 Pin AT-232 Signal AT-485 Signal

Pin 2 TXD RTS+ (HSO+)

Pin 3 RXD CTS+ (HSI+)

Pin 4 RTS RTS- (HSO-)

Pin 5 CTS TXD+

Table 2-2.  10-Position Modular Jack Pin Descriptions (Continued)

10-Position
Modular Jack AT-232 Signal AT-485 Signal

PIN 1

PIN 25PIN 13

PIN 14
AT Serial for Windows NT 2-8 © National Instruments Corporation
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Figure 2-7 shows how to connect the cables when you install a four-po
version of the AT serial board.

Figure 2-7.  Connecting the Cables to Your Four-Port AT Serial Board

Connecting Two-Wire Devices
The AT-485 boards are designed to work with either two- or four-wire 
devices. If you are using a two-wire device, refer to the device 
documentation for specific wiring instructions. 

In general, half-duplex networks use a single twisted pair of wires for 
communication in both directions, so you must connect both the transm
and the receiver at each end of the same pair of wires. For example, t
connect an RS-485 data acquisition device to a port on your AT-485 us

Pin 6 DSR* CTS– (HSI–)

Pin 7 GND RXD–

Pin 8 DCD* GND

Pin 20 DTR* RXD+

Pin 22 RI* TXD–

Pins not listed in this table are No Connect.

* These signals are not supported by the isolated 232 ports.

Table 2-3.  DB-25 Pin Descriptions (Continued)

DB-25 Pin AT-232 Signal AT-485 Signal

Serial Board

Additional 
Serial Cable

Additional 
Serial Cable

10-Position Modular Jack 
to DB-9 Cable

10-Position Modular Jack
 to DB-25 Cable

485 Terminator
(485 Boards Only)
© National Instruments Corporation 2-9 AT Serial for Windows NT
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half-duplex communication, you need a single twisted pair of wires. At 
AT-485, connect the TXD+ and RXD+ signals (pins 8 and 4 on a DB-9
connector, pins 5 and 20 on a DB-25 connector) together and to one w
Connect the other end of this wire to both the TXD+ and RXD+ signals
the data acquisition device. You use the same method to connect the T
and RXD– signals (pins 9 and 5 on a DB-9 connector, pins 22 and 7 o
DB-25 connector) to the second wire. 

Refer to Chapter 4, Using Your Serial Hardware, for information on setting 
the transceiver mode for two-wire communication. Refer to Appendix B
Serial Port Information, for more information on duplex architectures.
AT Serial for Windows NT 2-10 © National Instruments Corporation
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This chapter contains instructions to help you view or change the 
communication port settings.

Change/View Communication Port Settings
The serial configuration utility is fully integrated with the Windows NT 
Control Panel. You can use it to examine or modify the configuration of 
serial port. 

Follow these steps to configure the serial port.

1. Select Start»Settings»Control Panel and double-click on the niports 
icon. A list of National Instruments ports appears, as shown in 
Figure 3-1.

Figure 3-1.  niports Configuration Utility

2. Select the port you are interested in.

3. Click on the Settings button to view or configure the port settings. 
Refer to the next section, General Port Settings, for more information.
l for Windows NT
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4. Click on the Resources button in the General Port Settings dialog 
box to view or configure the resources for the port. Refer to the 
Resource Settings section, later in this chapter, for more information

5. Click on Delete to remove hardware information about the port from
Windows NT. You should do this before you remove the serial 
interface from the system.

General Port Settings
This section describes the options you can set in the General Port Settings 
dialog box, shown in Figure 3-2.

Figure 3-2.  General Port Settings Dialog Box

COM Port Number
You can use the COM Port Number  control to change the COMx name 
of the port selected.

Transceiver Mode
The transceiver mode selection shows the transceiver mode in use, a
applies only to AT-485 boards. Refer to Chapter 4, Using Your Serial 
Hardware, for more information about transceiver modes. If you use 
two-wire TXRDY mode, FIFOs must be enabled.
AT Serial for Windows NT 3-2 © National Instruments Corporation
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FIFO Enabled
You can use the FIFO Enabled control to enable or disable the FIFO 
buffers on the serial port. FIFO buffers are present on the 
16550-compatible UARTs—one for the transmitter and one for the 
receiver.

FIFO Buffer Size
FIFO buffers are present on the 16550-compatible UARTs—one for th
transmitter and one for the receiver. The receiver FIFO trigger denotes
number of characters received in the FIFO before the PC is interrupte
read the data. The transmit FIFO trigger denotes the maximum numbe
bytes written to the FIFO in a block when the PC is interrupted to write 
data. Consider the following points when selecting FIFO settings:

• You can select larger FIFO settings to reduce the number of interrup
and therefore minimize system overhead.

• If transfer rates are high, you can lower receive FIFO settings to reduce
the number of interrupts and therefore prevent overrun errors due to 
interrupt latency. 

• If data sizes are small, selecting receive FIFO settings just above data 
sizes can reduce efficiency, so select lower settings.

Resources
Click on the Resources button to display the resource configuration dialo
box for the port. For more information on resource configuration, refer
the next section, Resource Settings. 

Resource Settings
The following sections explain the resource configuration options for e
serial interface.

AT Boards (Shared IRQ)
Figure3-3 shows the PnP Port Configuration dialog box for an AT-232/4 
with shared IRQ. The dialog boxes for other shared IRQ AT boards ar
similar.
© National Instruments Corporation 3-3 AT Serial for Windows NT
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Figure 3-3.  PnP Port Configuration Dialog Box for the AT-232/4 

Each shared IRQ AT board requires multiple base I/O settings (one for e
port) and one IRQ that is shared between the ports.

Input/Output Range: Each Input/Output Range listing 
displays the I/O address ranges assigne
to the corresponding port on the board.

Interrupt Request: The IRQ shared between the ports on th
board.

Note The niports utility informs you if your resources conflict with the resources of an
other interface in the system. It does not check for conflicts with ports on the sa
board. Make sure to assign base I/O addresses that do not conflict with those 
assigned to another port on the same board.

Note If you are unable to change the base I/O address by double-clicking on the 
Input/Output Range control, select a different Basic Configuration in the 
Setting based on: control.
AT Serial for Windows NT 3-4 © National Instruments Corporation
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AT Boards (Non-Shared IRQ)
Each port on the board requires one I/O window and one IRQ.

Input/Output Range: The base I/O address range assigned to
the port.

IRQ: The IRQ assigned to the port.
© National Instruments Corporation 3-5 AT Serial for Windows NT
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Using Your Serial Hardware

This chapter describes how to set the hardware transceiver control mod
your RS-485 interfaces and lists some general programming requirem

Advanced Transceiver Control for the AT-485
The AT-485 boards support four modes of hardware transceiver contr
(Transceiver modes apply only to these interfaces.) You can use hard
flow control to enable and disable your transmitters and receivers to w
on different bus topologies. Table 4-1 lists the status of the transmitters
receivers under each of the transceiver control modes.

Note Signal names with an overscore, such as DTR, indicate that the signal is 
active low.

Four-Wire Mode
Use the four-wire mode for most full-duplex systems. In this mode, the
transmitter and receiver are always enabled. This mode is the default.

Two-Wire Mode: DTR with Echo
Use this mode in half-duplex systems where the DTR (Data Terminal 
Ready) line must control the transmitter. In the DTR-with-echo mode, the 
transmitter is tri-stated when the DTR signal of the UART (Universal 

Table 4-1.  Transceiver Control Modes

Mode Transmitter Receiver

Four-wire mode Always enabled Always enabled

Two-wire mode: 
DTR with echo

Enabled with 
DTR unasserted

Always enabled

Two-wire mode: 
DTR controlled

Enabled with 
DTR unasserted

Enabled with 
DTR asserted

Two-wire mode: 
TXRDY auto control

Enabled with 
TXRDY asserted

Enabled with 
TXRDY unasserted
l for Windows NT
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Asynchronous Receiver/Transmitter) is asserted. To transmit, your 
application must first clear the DTR bit to enable the transmitter. After the
data is fully transmitted, your application once again sets the DTR bit to 
disable the transmitter. Because the receiver is always enabled in this
mode, you not only receive packets from other devices, you also receiv
packets sent from your transmitter.

Two-Wire Mode: DTR Controlled 
This mode is similar to the two-wire, DTR-with-echo mode. Use this mode
in half-duplex systems where the DTR line must control the transmitter. 
Although this mode uses the same method as the DTR-with-echo mode to 
control the transmitter, the hardware automatically disables the receiv
whenever the transmitter is enabled. Thus, you do not receive packets
you have transmitted. 

Two-Wire Mode: TXRDY Auto Control
In this mode, the hardware transparently enables the transmitter and 
receiver in a two-wire system. This mode removes the burden of flow 
control from the user software. By connecting the transmitter to the 
TXRDY (Transmit Ready) line, the hardware enables the transmitter f
each byte to be transmitted. Also, the hardware disables the receiver 
whenever the transmitter is enabled, so you do not receive packets th
you have transmitted.

Note It is recommended that you use the two-wire TXRDY auto control mode when 
you are communicating with a two-wire device. Because this mode handles th
transmitter/receiver enabling for a two-wire connection in your hardware, 
it reduces the software overhead required to perform this operation in your 
application program. For more information about serial communication in 
two- or four-wire modes, refer to the section Serial Communication Issues in 
Appendix B, Serial Port Information.

Setting the Transceiver Control Mode
The recommended method for setting the transceiver control mode is 
the serial configuration utility located in the Windows NT Control Pane
For more information, refer to the General Port Settings section in 
Chapter 3, Configuration. The mode you select in the Control Panel is 
automatically configured when you open a port on a serial interface. 
AT Serial for Windows NT 4-2 © National Instruments Corporation
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Setting the Transceiver Mode with DeviceIoControl
The NI Serial software extends the Windows function DeviceIoControl  
for programming the transceiver control mode. To program the transce
control mode using DeviceIoControl , complete the following steps.

1. Add the following lines to your source code.

#include <winioctl.h>

#define IOCTL_SERIAL_SET_TRANSCEIVER_MODE

CTL_CODE(FILE_DEVICE_SERIAL_PORT,37,

METHOD_BUFFERED,FILE_ANY_ACCESS)

2. Use the Win32 function DeviceIoControl . Use the defined control 
code value listed in Step 1 to set the transceiver mode, and the in
buffer values (unsigned long) listed in Table 4-2 for programming 
different transceiver modes.

For example, to set two-wire TXRDY auto control mode, use the following
call:

ULONG TranceiverMode = 131;

DeviceIoControl( hDevice ,

IOCTL_SERIAL_SET_TRANSCEIVER_MODE,(PVOID)

&TransceiverMode,sizeof(ULONG), lpOutBuffer ,

nOutBufferSize , lpBytesReturned , lpOverlapped );

Table 4-2.  DeviceIoControl Function Input Values

Transceiver Mode
DeviceIoControl 

Function Input Value

Four-wire mode 128

Two-wire mode: DTR with echo 129

Two-wire mode: DTR controlled 130

Two-wire mode: TXRDY auto control 131
© National Instruments Corporation 4-3 AT Serial for Windows NT
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General Programming Requirements
Once installed, the NI Serial software is integrated into the standard 
Windows NT communications software. NI serial ports are used like a
other Windows NT communications (COM) port. Windows NT has 
standard communication functions for use within either 16-bit (Win16)
applications or 32-bit (Win32) applications.

As you begin developing your application, remember that you must us
the standard Microsoft Windows serial communication functions. For 
information about Microsoft Windows serial communication functions, 
refer to the Win32 Software Development Kit, online help for Win32 
Overviews, and Win32 Reference.

If you have LabVIEW or LabWindows and want to use it with your seri
hardware, refer to your LabVIEW or LabWindows documentation for 
information about serial I/O functions.
AT Serial for Windows NT 4-4 © National Instruments Corporation
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Specifications

This appendix describes the characteristics of the serial hardware, the
NI Serial software, and the recommended operating conditions.

Hardware Specifications

Table A-1.  Physical Characteristics of the Two-Port AT Serial Boards (Non-Isolated)

Characteristic Specification

Dimensions 10.67 by 16.51 cm
(4.2 by 6.5 in.)

I/O Connector DB-9

Power Requirement
(from PC AT I/O channel)

AT-485/2

AT-232/2 

AT-485/2 (Shared IRQ)

AT-232/2 (Shared IRQ)

+5 VDC 390 mA Typical
510 mA Maximum

+5 VDC 260 mA Typical
340 mA Maximum

+5 VDC 140 mA Typical
180 mA Maximum

+5 VDC 70 mA Typical
100 mA Maximum
l for Windows NT
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Table A-2.  Physical Characteristics of the Two-Port Isolated AT Serial Boards

Characteristic Specification

Dimensions 10.67 by 18.70 cm
(4.2 by 7.4 in.)

I/O Connector DB-9

Isolation Voltage

From Port to Port

From Any Port to Host
Computer

3000 Vrms/60s

2000 Vrms/60s

Power Requirement
(from PC AT I/O channel)

AT-485/2 Isolated

AT-232/2 Isolated

+5 VDC 220 mA Typical
260 mA Maximum

+5 VDC 160 mA Typical
200 mA Maximum

Table A-3.  Physical Characteristics of the Four-Port AT Serial Boards (Non-Isolated)

Characteristic Specification

Dimensions 10.67 by 16.51 cm
(4.2 by 6.5 in.)

I/O Connector 10-position modular jack

Power Requirement
(from PC AT I/O channel)

AT-485/4

AT-232/4 

AT-485/4 (Shared IRQ)

AT-232/4 (Shared IRQ)

+5 VDC 160 mA Typical
200 mA Maximum

+5 VDC 110 mA Typical
150 mA Maximum

+5 VDC 160 mA Typical
200 mA Maximum

+5 VDC 110 mA Typical
150 mA Maximum

* The four-port AT serial board requires cables to convert the 10-position modular jack 
either DB-9 or DB-25 connectors.
AT Serial for Windows NT A-2 © National Instruments Corporation
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Table A-4.  Physical Characteristics of the Four-Port Isolated AT Serial Boards

Characteristic Specification

Dimensions 10.67 by 25.40 cm
(4.2 by 10.0 in.)

I/O Connector 10-position modular jack

Isolation Voltage

From Port to Port

From Any Port to Host
Computer

3000 Vrms/60s

2000 Vrms/60s

Power Requirement
(from PC AT I/O channel)

AT-485/4 Isolated

AT-232/4 Isolated

+5 VDC 300 mA Typical
360 mA Maximum

+5 VDC 280 mA Typical
320 mA Maximum

* The four-port isolated AT serial board requires cables, which are included in your kit, 
convert the 10-position modular jack to a DB-9 connector. Use only the types of cable
provided in your kit.

Table A-5.  Environmental Characteristics of the Serial Hardware

Characteristic Specification

Operating Environment

Component Temperature
Relative Humidity

0° to 70° C
10% to 90%, noncondensing

Storage Environment

Temperature
Relative Humidity

–40° to 120° C
5% to 90%, noncondensing

EMI

AT Serial
AT Serial Isolated

FCC Class B Certified
FCC Class A Verified
© National Instruments Corporation A-3 AT Serial for Windows NT
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Software Specifications

Table A-6.  Software Characteristics

Characteristic Specification

Maximum Serial Transfer Rate 115,200 bps*

Space Required for NI Serial Software 1 MB

* Actual speed may vary considerably from speed shown due to system and 
instrumentation capabilities.
AT Serial for Windows NT A-4 © National Instruments Corporation
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Serial Port Information

This appendix discusses the RS-232, RS-422, and RS-485 standards
explains some of the issues involved with these types of serial 
communication.

RS-232
RS-232, as specified in the ANSI/EIA-232-D Standard, Interface Between 
Data Terminal Equipment and Data Circuit-Terminating Equipment 
Employing Serial Binary Data Interchange, standardizes serial 
communication between computers and between computer terminals 
modems. Most applications use the RS-232 standard for interfacing 
peripherals to personal computers. RS-232 uses transmission lines in w
the state of each signal is represented by referencing the voltage leve
single line to ground. RS-232 was designed for serial communication u
distances of 50 ft. and with data rates up to 20 kb/s. However, becaus
improvements in line drivers and cabling, you can often increase the ac
performance of the bus past the limitations on speed and distance 
recommended in the specification.

RS-422
RS-422, as specified in the EIA RS-422-A Standard, Electrical 
Characteristics of Balanced Voltage Digital Interface Circuits, defines 
a serial interface much like RS-232. However, RS-422 uses balanced 
(or differential) transmission lines. Balanced transmission lines use tw
transmission lines for each signal. The state of each signal is represen
not by a voltage level on one line referenced to ground as in RS-232, 
rather by the relative voltage of the two lines to each other. For examp
the TX signal is carried on two wires, wire A and wire B. A logical 1 is 
represented by the voltage on line A being greater than the voltage on
line B. A logical 0 is represented by the voltage on line A being less th
the voltage on line B. Differential voltage transmission creates a signal 
is much more immune to noise as well as voltage loss due to transmis
line effects. Thus, you can use RS-422 for much longer distances 
(up to 4,000 ft.) and much greater transmission speeds (up to 10 Mb/s
than RS-232. 
l for Windows NT



Appendix B Serial Port Information

tal 
 

-485 
nal 

to 

ards.
RS-485
RS-485, as specified in the EIA-485 Standard, Standard for Electrical 
Characteristics of Generators and Receivers for Use in Balanced Digi
Multipoint Systems, expands on the RS-422 standard by increasing the
number of devices you can use from 10 to 32 and by working with 
half-duplex bus architectures. Unlike the RS-422 standard, RS-485 
addresses the issue of using multiple transmitters on the same line. RS
defines the electrical characteristics necessary to ensure adequate sig
voltages under maximum load, short-circuit protection, and the ability 
withstand multiple drivers driving conflicting signals at the same time.

Table B-1 lists the features of the RS-232, RS-422, and RS-485 stand

Table B-1.  RS-232, RS-422, and RS-485 Features

Feature RS-232 RS-422 RS-485

Type of 
transmission lines

Unbalanced Differential Differential

Maximum number 
of drivers

1 1 32

Maximum number 
of receivers

1 10 32

Maximum cable 
length

50 ft. 4,000 ft. 4,000 ft.

Maximum data rate 20 kb/s 10 Mb/s 10 Mb/s

Maximum CMV ± 25 V ±7 V +12 to –7 V

Driver output 5 to 25 V 2 to 6 V 1.5 to 6 V

Driver load >3 kΩ 100 Ω 60 Ω
AT Serial for Windows NT B-2 © National Instruments Corporation
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Serial Communication Issues
This section explains some serial communication issues, such as dup
architectures, termination methods, bias resistors, and types of conne
equipment.

Duplex Architectures
Duplex refers to the means of bandwidth usage in a serial system. The
common means of bi-directional serial communication are full duplex a
half duplex. Half-duplex communication involves a transmitter and a 
receiver connected to each end of the same wire or pair of wires. Bec
the same transmission line is used for both sending and receiving data
devices cannot send data in both directions at the same time. First, on
device transmits over the wire(s) to the receiver of the second device. W
the first device finishes transmitting, both devices switch the connectio
from their transmitter to their receiver or vice versa. The device that w
receiving data can then transmit over the line.

In full-duplex communication, the devices use a separate wire (or pair
wires) for simultaneous transmission in each direction. Thus, there is n
need to switch between transmitting and receiving.

In a differential serial bus (for example, RS-422 or RS-485), a half-dup
system can transmit and receive over the same twisted pair of wires. 
Thus, half-duplex communication is often referred to as two-wire 
communications. Likewise, full-duplex communication is often referred
as four-wire communications, because the full-duplex system uses a 
separate pair of wires for communication in each direction.
© National Instruments Corporation B-3 AT Serial for Windows NT
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Full Duplex
A typical full-duplex multidrop bus architecture involves a master-slave
protocol. Only one device, the master, can control access to the bus. A
other devices are slaves. Slave devices must wait for the master to give 
access to the bus. In a typical full-duplex system, one transmission lin
connects the bus master’s transmitter to all of the slave receivers. A se
transmission line connects all of the slave transmitters to the bus mas
receiver. Because in a differential system each transmission line is 
composed of two separate wires, a full-duplex system is often referred 
a four-wire system. Figure B-1 shows a typical full-duplex system.

Figure B-1.  Typical Full-Duplex System

Half Duplex
A typical half-duplex multidrop bus architecture also involves a 
master-slave protocol. In a half-duplex system, all transmitters and 
receivers are connected to the same transmission line. A half-duplex sy
is often referred to as a two-wire system. Figure B-2 shows a typical 
half-duplex system.

Figure B-2.  Typical Half-Duplex System
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Termination
Because each differential pair of wires is a transmission line, you mus
properly terminate the line to prevent reflections. A common method o
terminating a two-wire multidrop RS-485 network is to install terminatin
resistors at each end of the multidrop network. If you daisy-chained 
multiple instruments together, you need a terminating resistor at only t
first and last instruments. The terminating resistor should match the 
characteristic impedance of the transmission line (typically 100–120Ω). 
National Instruments offers an optional DB-9 RS-485 termination 
connector that contains embedded terminating resistors for easy 
termination. 

Figure B-3 shows a multidrop network using terminating resistors.

Figure B-3.  Multidrop Network Using Terminating Resistors

Bias Resistors
A transmission line enters an indeterminate state if no nodes are 
transmitting on it. This indeterminate state can cause the receivers to 
receive invalid data bits from noise picked up on the cable. To prevent th
data bits, you should force the transmission line into a known state. By
installing two 620 Ω bias resistors at one node on the transmission line, y
can create a voltage divider that forces the voltage between the differe
pair to be less than 200 mV, the threshold voltage for the receiver. You
should install these resistors on only one node. 
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Figure B-4 shows a transmission line using bias resistors.

Figure B-4.  Transmission Line Using Bias Resistors

Rather than using two 620 Ω resistors at one node, you can also increas
the value of the resistors and put them at every node. For instance, if t
are eight nodes in a system, you can use 4.7 kΩ resistors at each node to 
effectively achieve the same result.

DTE vs. DCE
Data Terminal Equipment (DTE) and Data Communications Equipmen
(DCE) were the terms used in the RS-232 specification for the types o
equipment on either end of a serial connection. (A DCE is called Data
Circuit-Terminating Equipment in Revision D of the RS-232 specification
In general, DTE and DCE refer to computer equipment and modems, 
respectively. Because the RS-232 specification mainly involves connec
a DTE directly to a DCE and vice versa, the pinouts are defined so tha
cabling is simple. That is, a cable connected a computer to a modem 
wiring pin 1 to pin 1, pin 2 to pin 2, and so on. This method is common
known as straight-through cabling. 

620 Ω
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+5

A

Tx

B

620 Ω
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100 Ω
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Figure B-5 shows straight-through cabling in a DTE-to-DCE interface.

Figure B-5.  Straight-Through Cabling in a DTE-to-DCE Interface

Straight-through cabling is still the standard method to connect a mode
your PC. However, because many applications use serial communicatio
connect two or more DTEs without modems, the cabling becomes mo
complicated. If two DTEs are wired together using a straight-through ca
one transmitter is connected to the other transmitter, and one receiver
connected to the other receiver. In this setup, no transmissions can oc
Thus, these applications must use a cabling scheme that connects the
transmitter on one device to the receiver on the other device and vice v
This method is known as null-modem cabling, because it replaces the two
modems that traditional RS-232 applications would require between th
two DTEs. You should use a null-modem cable to communicate from o
serial port to another. 

Figure B-6 shows null-modem cabling in a DTE-to-DTE interface.

Figure B-6.  Null-Modem Cabling in a DTE-to-DTE Interface

Rx D

Tx DPin 3

Pin 2
DTE

Pin 3

Pin 2
DCE

Pin 3

Pin 2
DCE

Pin 3

Pin 2
DTE

Rx D

Tx D

Rx D

Tx D

Rx D

Tx D
Pin 2

Pin 3Pin 3

Pin 2
DTE DTE
© National Instruments Corporation B-7 AT Serial for Windows NT



© National Instruments Corporation C-1 AT Seria
C

rial 

-1. 
Uninstalling the Serial 
Hardware and Software

This appendix explains how to uninstall your serial hardware and NI Se
software.

Removing the Hardware Information
Before physically removing the serial hardware, you must remove the 
hardware information from the Windows NT Control Panel. 

Follow these steps to uninstall the hardware:

1. Double-click on the niports icon under Start»Settings»Control 
Panel.

2. Select the port to remove from the list of ports as shown in Figure C

Figure C-1.  Selecting an Interface to Uninstall
l for Windows NT
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3. Click on the Delete button.

Note For shared IRQ AT boards, all ports on the interface are removed.

Uninstalling the NI Serial Software
Before uninstalling the software, remove all serial port information from
the Windows NT Control Panel, as described in the previous section. Y
do not need to shut down Windows NT before uninstalling the softwar

Complete the following steps to remove the NI Serial software.

1. Select Start»Settings»Control Panel.

2. Double-click on the Add/Remove Programs icon in the Control Panel 
to launch the Add/Remove Programs applet. A dialog box similar 
the one in Figure C-2 appears. This dialog box lists the software 
available for removal. 

Figure C-2.  Add/Remove Programs Properties Dialog Box
AT Serial for Windows NT C-2 © National Instruments Corporation
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3. Select the serial software you want to remove, and click on the 
Add/Remove button. The uninstall program runs and removes all 
folders, utilities, and registry entries associated with the NI Serial 
software. Figure C-3 shows the results of a successful uninstallati

Figure C-3.  Uninstallation Results

4. Shut down Windows NT, power off your computer, and remove yo
serial interfaces. 

If you want to reinstall the hardware and software, refer to Chapter 2, 
Installation and Verification.
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Troubleshooting and 
Common Questions

This appendix describes how to troubleshoot problems and answers s
common questions.

Missing Serial Port in the niports List
The serial configuration utility niports contains configuration information 
for serial hardware it is aware of that is installed in your system. 

To start the configuration utility, select Start»Settings»Control Panel, 
and double-click on the niports icon.

If your AT serial board is missing from the list, follow these steps:

1. Make sure the hardware is installed.

2. Make sure you have installed the Microsoft PnP ISA Enabler drive
niports cannot recognize the AT boards without the Microsoft PnP
ISA Enabler driver. For more information, refer to the Installing the 
Microsoft PnP ISA Enabler Driver section of Chapter 2, Installation 
and Verification.

Resolving Resource Conflicts
Resource conflicts occur when your system contains hardware that is 
configured to use the same resources as your serial interface. The se
driver detects some resource conflicts when it loads. When the driver 
detects conflicts as it loads, it records an error message describing th
conflict. You can use the Event Viewer to see which resource is in conf
To run the Event Viewer, select Start»Programs»Administrative 
Tools»Event Viewer.

After you have identified the resource that caused the conflict, use the s
configuration utility, niports, to reconfigure your serial interface so that i
uses conflict-free resources. For more information, refer to Chapter 3,
Configuration.
l for Windows NT
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To help in the selection of conflict-free resources, Microsoft has provid
a utility called Windows NT Diagnostics. This utility displays a list of th
I/O port addresses, IRQ levels, and DMA channels that are currently b
used in your system. Assign resources not listed by this utility to your se
interface.

To run the Windows NT Diagnostics, select Start»Programs» 
Administrative Tools»Windows NT Diagnostics.

Troubleshooting Diagnostic Messages
This section lists possible diagnostic error messages, along with solut

• If the No National Instruments serial port found  error 
message appears, refer to Chapter 2, Installation and Verification, to 
follow these troubleshooting steps:

1. Verify the hardware resources. To verify the hardware resourc
click on the Resources button on the General Port Settings page. 
For more information about resource conflicts, refer to Chapter
Configuration.

2. Verify that the National Instruments serial driver is installed. U
the Windows Explorer to display the Properties of serial.sys .

3. If either the serial hardware or serial.sys  file is missing, 
reinstall the hardware and software. You should find serial.sys  
in the \WinNT\system32\drivers  directory.

• If the utility reports fewer ports installed than it should, refer to 
Chapter 2, Installation and Verification, and follow these 
troubleshooting steps: 

1. Verify the hardware resources.

2. Verify that the National Instruments serial driver is installed. U
the Windows Explorer to display the Properties of serial.sys .

3. Check the hardware installation to make sure the correct num
of boards/ports are installed.

• If the I/O address test failed, Interrupt test cannot 

be performed.  error message appears, verify the hardware resour
as described in Chapter 3, Configuration. If the test still fails, you 
probably have an I/O address conflict with legacy boards in your 
system. Use the niports configuration utility to change the base I/O 
addresses assigned to your ports. For more information, refer to 
Chapter 3, Configuration.
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• If the Interrupt test failed  error message appears, verify the
hardware resources as described in Chapter 3, Configuration. If the 
test still fails, you probably have an IRQ conflict with legacy boards
your system. Use the niports configuration utility to change the IRQ 
level assigned to your port. For more information, refer to Chapter
Configuration.

Common Questions
How can I determine which type of serial hardware I have installed?

Double-click on the niports icon under Start»Settings»Control Panel to 
display a list of installed ports. 

What do I do if the diagnostic test fails with an error?

Refer to the troubleshooting sections of this manual for specific 
information about what might cause the test to fail.

How can I determine which port is associated with COMx?

Refer to the section Determine Which Physical Port Is Associated with 
COMx, in Chapter 2, Installation and Verification.

How can I name National Instruments serial ports COM1, COM2, 
COM3, or COM4?

Refer to the General Port Settings section in Chapter 3, Configuration.

How can I determine which version of the NI Serial software I have 
installed?

The Read Me file gives the version of the software. To read the file, sele
Read Me under Start»Programs»National Instruments Serial.

How many interrupts are required for my serial interface?

If you have a shared IRQ card or an isolated serial card, you need one
interrupt per card. This is the hardware that currently ships with 
Windows NT. 

If you have an older, non-shared IRQ card, you need as many interrup
there are ports on the card.
© National Instruments Corporation D-3 AT Serial for Windows NT
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What information should I have before I call National Instruments?

When you call National Instruments, you should have the results of th
Diagnostic test. Also, make sure you have filled out the hardware and 
software configuration form in Appendix E, Customer Communication.
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Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessa
to help us solve your technical problems and a form you can use to comment on the product 
documentation. When you contact us, we need the information on the Technical Support Form
the configuration form, if your manual contains one, about your system configuration to answer
questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to
provide the information you need. Our electronic services include a bulletin board service, an FT
a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first 
electronic support systems. If the information available on these systems does not answer you
questions, we offer fax and telephone support through our technical support centers, which are
by applications engineers. 

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
and documents to answer most common customer questions. From these sites, you can also d
the latest instrument drivers, updates, and example programs. For recorded instructions on how
the bulletin board and FTP services and for BBS automated information, call 512 795 6990. Yo
access these services at:

United States: 512 794 5422
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635 551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com , as anonymous  and use 
your Internet address, such as joesmith@anywhere.com , as your password. The support files and
documents are located in the /support  directories.
l for Windows NT
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Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a
range of technical information. You can access Fax-on-Demand from a touch-tone telephone a
512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mai
Internet address listed below. Remember to include your name, address, and phone number so
contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technic
support number for your country. If there is no National Instruments office in your country, cont
the source from which you purchased your software to obtain support.

Country Telephone Fax
Australia 03 9879 5166 03 9879 6277
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Brazil 011 288 3336 011 288 8528
Canada (Ontario) 905 785 0085 905 785 0086
Canada (Quebec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 09 725 725 11 09 725 725 55
France 01 48 14 24 24 01 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Israel 03 6120092 03 6120095
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 5 520 2635 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
United Kingdom 01635 523545 01635 523154
United States 512 795 8248 512 794 5678
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Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, a
the completed copy of this form as a reference for your current configuration. Completing this f
accurately before contacting National Instruments for technical support helps our applications 
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem
include the configuration forms from their user manuals. Include additional pages if necessary.

Name ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

Fax ( ___ ) ________________Phone ( ___ ) ______________________________________

Computer brand____________ Model ___________________Processor _____________________

Operating system (include version number) ________________________________________

Clock speed ______MHz   RAM _____MB Display adapter ________________________

Mouse ___yes   ___no     Other adapters installed___________________________________

Hard disk capacity _____MB Brand______________________________________________

Instruments used _____________________________________________________________

___________________________________________________________________________

National Instruments hardware product model _____________ Revision  ____________________

Configuration _______________________________________________________________

National Instruments software product ___________________ Version  _____________________

Configuration _______________________________________________________________

The problem is: ______________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

List any error messages: _______________________________________________________

___________________________________________________________________________

___________________________________________________________________________

The following steps reproduce the problem: _______________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________
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Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each
Complete a new copy of this form each time you revise your software or hardware configuration
use this form as a reference for your current configuration. Completing this form accurately bef
contacting National Instruments for technical support helps our applications engineers answer 
questions more efficiently.

National Instruments Products
Serial hardware and revision ___________________________________________________

AT-232 board revision _______________________________________________________

Two port________________ Four port_________________Isolated _______________

AT-485 board revision

Two port________________ Four port_________________Isolated _______________

NI serial software revision number on distribution disk

Hardware settings:

Base I/O Address Interrupt Level

COM1 ________________  _________________

COM2 ________________  _________________

COM3 ________________  _________________

COM4 ________________  _________________

COM5 ________________  _________________

COM6 ________________  _________________

COM7 ________________  _________________

COM8 ________________  _________________

COM9 ________________  _________________

Other Products
Computer make and model ____________________________________________________

Microprocessor ______________________________________________________________

Clock frequency or speed ______________________________________________________

Type of monitor card installed ___________________________________________________

Windows version ____________________________________________________________

Application programming language (Microsoft C, Visual Basic for Windows) ______________

___________________________________________________________________________

Number of serial ports in system:

Built in __________________________  Adapter cards __________________________

Other boards in system ________________________________________________________

Base I/O address of other boards _______________________________________________

Interrupt level of other boards __________________________________________________
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Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our pro
This information helps us provide quality products to meet your needs.

Title: Getting Started with Your AT Serial Hardware and Software for Windows NT

Edition Date: August 1998

Part Number: 321572C-01

Please comment on the completeness, clarity, and organization of the manual.

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

Thank you for your help.

Name _____________________________________________________________________

Title ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

E-Mail Address ______________________________________________________________

Phone ( ___ ) __________________________  Fax ( ___ ) ___________________________

Mail to: Technical Publications Fax to: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway 512 794 5678
Austin, Texas 78730-5039
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Prefix Meanings Value

m- milli- 10–3

c- centi- 10–2

k- kilo- 103

M- mega- 106

° degrees

% percent

Ω ohms

A amperes

ANSI American National Standards Institute

b bits

B bytes

baud bits per second

bps bits per second

C Celsius

COM Computer Output Microform

CTS Clear To Send

DB-xx subminiature D connector (where xx is the number of pins)

DCD Data Carrier Detect

DCE Data Communications Equipment or Data Circuit-Terminating Equipm

DMA direct memory access

DSR Data Set Ready
© National Instruments Corporation G-1 AT Serial for Windows NT
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DTE Data Terminal Equipment

DTR Data Terminal Ready (where the overscore denotes that the signal 
is active low)

EIA Electronic Industries Association

EMI electromagnetic interference

FCC Federal Communications Commission

FIFO first-in-first-out

ft. feet

GND Ground

HSI Handshake Input

HSO Handshake Output

Hz hertz

IEEE Institute of Electrical and electronic Engineers

in. inches

I/O input/output

IRQ interrupt request

ISA Industry Standard Architecture

Kbaud kilobits per second

m meters

MB megabytes of memory

PC personal computer

PCI Peripheral Components Interconnect

PCMCIA Personal Computer Memory Card International Association

PnP Plug and Play

RAM random-access memory
AT Serial for Windows NT G-2 © National Instruments Corporation
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 low)
RI Ring Indicator

RTS Request to Send

RX Receive

RXD Receive Data

s seconds

SCSI Small Computer Systems Interface

TX Transmit

TXD Transmit Data

TXRDY Transmit Ready  (where the overscore denotes that the signal is active

UART universal asynchronous receiver/transmitter

V volts

VDC volts direct current

VXI VME eXtensions for Instrumentation
© National Instruments Corporation G-3 AT Serial for Windows NT
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